Authors:

Cassandra Tex, MBA
Assistive Technology Specialist
Humboldt State University

Kimberly Vincent-Layton, MBA
Instructional Technologist
Humboldt State University

Editor:

Mark Turner, M.A.
CSU Office of the Chancellor
Accessible Technology Initiative

CSU Standards and Techniques Guide for Creating Accessible Microsoft Word 2010 Documents by CSU Accessible Technology Initiative is licensed under a Creative Commons Attribution-NonCommercial-ShareAlike 3.0 Unported License.
Table of Contents

Introduction ...........................................................................................................................................9

1.0 Text Formatting with Styles ........................................................................................................10
   Explanation ..........................................................................................................................................10
   Working with Styles ..........................................................................................................................10
      Steps to View All of the Available Styles: ......................................................................................10
      Steps to Apply Styles to Text: ........................................................................................................11
      Steps to Modify a Style: ..................................................................................................................11
   A. Use Heading Styles to Convey Structure ....................................................................................13
      Explanation .......................................................................................................................................13
      Example ..........................................................................................................................................13
   B. Nest Heading Styles Appropriately ...............................................................................................13
      Explanation .......................................................................................................................................13
      Steps to use the Navigation Pane to View Nesting of Headings: ....................................................14
   C. Use Styles to Format Text ...............................................................................................................15
      Explanation .......................................................................................................................................15
      Emphasis Style ...............................................................................................................................15
      Strong Style ....................................................................................................................................16
      Body Text / Normal Style ..................................................................................................................16
   D. Control White Space in the Document with Styles ......................................................................16
      Explanation .......................................................................................................................................16
      Steps to Control White Space with Styles: .......................................................................................16
   E. Use List Formatting ........................................................................................................................17
      Explanation .......................................................................................................................................17
   F. Generate a Linked Table of Contents for Longer Documents ..........................................................17
      Explanation .......................................................................................................................................17
      Best Practice ....................................................................................................................................18
      Steps to Generate a Linked Table of Contents: .............................................................................18

2.0 Columns ..........................................................................................................................................19
   A. Use Column Formatting Instead of Tabs and Spaces ......................................................................19
      Explanation .......................................................................................................................................19
      Steps to Format Columns: ..............................................................................................................20

3.0 Tables ............................................................................................................................................20
A. Do Not Use Tables for Layout Purposes ................................................................. 20
   Explanation ........................................................................................................ 20

B. Do Not Draw Tables ............................................................................................. 21
   Explanation ........................................................................................................ 21
   Steps to Insert a Table: ...................................................................................... 21

C. Do Not use Heading Styles in Tables ................................................................. 22
   Explanation ........................................................................................................ 22
   Best Practice ...................................................................................................... 22

D. Split Complex Tables Up Into Simpler Tables Where Appropriate ................... 22
   Explanation ........................................................................................................ 22

E. Control White Space in Tables Using Table Properties .................................... 22
   Explanation ........................................................................................................ 22
   Steps to Create White Space in Table Cells: .................................................... 22

F. Rows of a Table Breaking Across Pages ............................................................. 23
   Explanation ........................................................................................................ 23
   Best Practice ...................................................................................................... 23
   Exception ........................................................................................................... 23
   Steps to Not Allow Rows to Break across Pages: .......................................... 24
   Steps to Allow Rows to Break across Pages: ................................................... 24

G. Set Header Row(s) to Repeat in Tables ............................................................... 25
   Explanation ........................................................................................................ 25
   Exception ........................................................................................................... 25
   Steps to Set a Header Row to Repeat in a Table: ......................................... 25
   Steps to Set Multiple Header Rows to Repeat in a Table: ........................... 26

H. Add Text Alternatives for Tables ........................................................................ 26
   Explanation ........................................................................................................ 26
   Exception ........................................................................................................... 26
   Steps to Provide Text Alternatives for Tables: ............................................. 27

I. Include Captions for Tables When Appropriate .................................................. 27
   Explanation ........................................................................................................ 27
   Best Practice ...................................................................................................... 27
   Steps to Provide Captions for Tables: ............................................................ 28

4.0 Hyperlinks ........................................................................................................... 28

A. Use Text for Hyperlinks rather than URL’s ....................................................... 28
   Explanation ........................................................................................................ 28
Example ......................................................................................................................... 28
Best Practice .................................................................................................................... 29
Steps to Footnote Descriptive Link Text to Provide Complete URL: ................................. 29
Exceptions...................................................................................................................... 29

B.  Ensure Link Text is Descriptive and Makes Sense When Read Out of Context .............. 29
Explanation .................................................................................................................... 29

C.  Ensure Link Text is Identical for the Same Destinations and Unique for Different Destinations ................................................................................................................................. 30
Explanation .................................................................................................................... 30
Exceptions...................................................................................................................... 30
Steps to Insert a Hyperlink (at the current cursor location): ............................................. 30
Steps to Convert Text to a Hyperlink: ............................................................................. 31
Steps to Edit a Hyperlink: ............................................................................................. 31

5.0 Non-Text Elements (Pictures, Images, Charts, etc.) ............................................. 32
A.  Provide Text Alternatives for all Non-Text Content .................................................. 32
Explanation .................................................................................................................... 32
Rationale ........................................................................................................................ 32
Example ........................................................................................................................ 33
Exceptions...................................................................................................................... 33
Steps to Provide Text Alternatives for Pictures, Images, and Clip Art: ............................... 33
Steps to Provide Text Alternatives for Shapes: .................................................................. 34
Steps to Provide Text Alternatives for SmartArt: ............................................................. 35
Steps to Provide Text Alternatives for Charts: ................................................................. 35
Steps to Not Provide Text Alternatives for Decorative Images: ........................................ 36

B.  Watermarks: Ensure Adequate Contrast and Add Text in the Document ..................... 37
Explanation .................................................................................................................... 37
Best Practice .................................................................................................................... 37

C.  Provide Additional Descriptions for Complex Images/Charts .................................... 38
Explanation .................................................................................................................... 38

D.  Place Graphics and Images "In Line with Text" ........................................................... 38
Explanation .................................................................................................................... 38
Steps to Place Graphics and Images "In Line with Text": .................................................. 38

E.  Avoid the use of Images of Text ................................................................................. 39
Explanation .................................................................................................................... 39
Exception ....................................................................................................................... 39

F.  Do Not Use Text Boxes ............................................................................................... 39
G. Provide Captions for Images When Appropriate

Explanation .................................................................................................................................... 41
Best Practice .................................................................................................................................. 41
Steps to Provide Captions for Images: .......................................................................................... 41

H. Do Not Use Drop Caps ............................................................................................................ 41

Explanation .................................................................................................................................... 41

6.0 Headers and Footers .................................................................................................................. 42

A. Observe the Following Rule for Header/Footer Content ............................................................ 42

Explanation .................................................................................................................................... 42
Acceptable Content .......................................................................................................................... 42
Unacceptable Content ...................................................................................................................... 42
Steps to Insert Header: .................................................................................................................. 42
Steps to Modify a Header: ............................................................................................................. 42
Steps to Insert Footer: .................................................................................................................... 43
Steps to Modify a Footer: ................................................................................................................ 43

7.0 Appropriate Use of Color .......................................................................................................... 44

A. Do Not Use Color Alone to Convey Information ..................................................................... 44

Explanation .................................................................................................................................... 44

8.0 Document Metadata ................................................................................................................ 45

A. Insert the Document Title in the Document Properties ............................................................. 45

Explanation .................................................................................................................................... 45
Best Practice: Insert Other Document Metadata As Deemed Appropriate .................................. 46
Steps for inserting document metadata, including document title: .............................................. 46

B. Set the Language Properties for the Document ....................................................................... 46

Explanation .................................................................................................................................... 46
Steps to Set the Language Properties for the Document: ............................................................. 47

C. Identify Changes in Language for Text (Phrases, Sentences, etc.) ......................................... 47

Explanation .................................................................................................................................... 47
Exceptions ....................................................................................................................................... 47
Steps for Identifying Changes in Language for Text (Words, Phrases, etc.): ................................ 47

Document Readability .................................................................................................................. 48
Introduction

This document contains the standards for accessible Microsoft Word 2010 documents as defined by the California State University (CSU) Chancellor’s Office and the techniques for implementing the standards. The purpose of this document is to provide individuals with the in-depth rationale for why each standard was selected. In addition to the standards and techniques for implementation, several best practices have been included. In some cases, it may not be appropriate to identify a specific standard. However, there may be well-established industry best practices that, when used, will result in a document that is more accessible. In those instances, the best practices have been identified, and it is highly recommended that they be followed.

The standards selected were influenced by those portions of the WCAG 2.0 (Web Content Accessibility Guidelines) guidelines for web accessibility that are applicable to Microsoft Word documents. In addition, this document pulls explanations and intentions from the draft version of Chapter 5 of the Section 508 Refresh. Though these CSU standards are informed by well-established and authoritative documents which are organized by concept or principle (e.g., provide text alternatives for any non-text content), this document is organized by object type (e.g., Non-text elements). The authors hope that the object-type organization will assist document authors in locating specific sections quickly. For example, if a document author has a question about how to make tables accessible, it may not be obvious what section to reference in a conceptually-organized document. Since this document is organized by object-type, the author would simply go to the section on Tables.

An attempt was made to make this document less technical than the referenced documents (WCAG 2.0 and Chapter 5 of the Section 508 Refresh). However, in certain places, the technical jargon was deemed appropriate and well-stated so the language was not altered.

This guide was written using Microsoft Word 2010, using the default file format of .docx, and assumes that document authors are using this version and file format as well. These assumptions were made because of the differences between .docx and compatibility mode (.doc); the dialog boxes and steps necessary to complete tasks are slightly different when working in compatibility mode (.doc). If you find discrepancies between the steps provided and screen shots in this guide and what you experience in your documents, please check to ensure you are not in compatibility mode. In certain instances, it may be necessary to work in compatibility mode and save documents using the older .doc file format. This guide is not discouraging that practice.

Following are the standards for creating accessible Microsoft Word 2010 documents as well as the techniques for meeting the standards. By following these standards and techniques, one can be reasonably assured that their Word documents will be accessible to all individuals, regardless of ability or assistive technology needs.

---

1 W3C WCAG 2.0 Guidelines: [http://www.w3.org/TR/WCAG20/](http://www.w3.org/TR/WCAG20/)
2 Access Board Site for Section 508 Refresh: [http://www.access-board.gov/sec508/refresh/draft-rule.htm#documents](http://www.access-board.gov/sec508/refresh/draft-rule.htm#documents)
1.0 Text Formatting with Styles

Explanation
It is important to ensure that the structure of the document can be programmatically determined by the assistive technology. If all the information in the document is available in a form that can be determined by software, then it may be presented to users in different ways (visually, audibly, tactiley, etc.). When such relationships are perceivable to one set of users, those relationships can be made to be more perceivable for most users. If information is embedded in a particular presentation in such a way that the structure and information cannot be programmatically determined by the assistive technology, then it cannot be rendered in other formats as needed by the user.

Working with Styles
Structure is added to documents by using styles. Styles are formatting instructions and help all of your readers make sense of your documents. Using styles helps your readers to visually get a sense of the structure of your document, and it helps individuals using assistive technologies, such as screen readers, as well. Screen reading software can detect these formatting instructions (styles) and inform the reader of these structural/style instructions. In addition, an individual using a screen reader may navigate the document by heading level, thus getting an overall sense of the structure of the document without having to read the entire document.

Sighted users perceive structure through various visual cues — headings are often in a larger, bold font separated from paragraphs by blank lines; list items are preceded by a bullet and perhaps indented; paragraphs are separated by a blank line; items that share a common characteristic are organized into tabular rows and columns; words that have special status are indicated by changing the font family and/or bolding, italicizing, or underlining them, and so on. All of this can be accomplished with the use of styles.

Steps to View All of the Available Styles:

See Figure 1
1) Select the Home tab
2) Select the Styles group expansion arrow (Word will display the Styles pane)
3) Select Options…. (the Style Pane Options dialog box opens)
4) Select “All styles” under “Select styles to show:"
5) Select “Alphabetical” under “Select how list is sorted:"
6) Select whether you want the Styles pane to show all styles on this document only or on new documents based on this template
7) Select OK
Figure 1: Steps to View All Styles

Steps to Apply Styles to Text:

See Figure 2
1) Select the text you would like to format with a style
2) Select the name of the style you would like to apply from the list in the Styles pane (not the down arrow next to the name)

Figure 2: Steps to Apply Styles to Text

Steps to Modify a Style:

Modifier Beware! Sometimes after a style is modified, unexpected things happen. Be prepared to experiment with the styles, and do not add the style to the template unless you are absolutely certain. Do not modify the Normal style. In addition, it is recommended that you NEVER select the box, “Automatically Update” because Word will make global changes to the styles in your document and all associated templates.
See Figure 3
1) In the Styles pane, hover over the style you want to modify
2) Select the down arrow to the right of the style name
3) Select Modify…
4) Make your changes by changing the font, paragraph, borders, etc.
5) Select whether you want the changes to apply to this document only or to new documents based on this template
6) Select OK

Figure 3: Steps to Modify a Style

Microsoft Word offers many built-in styles. The most common styles you will be using are explained below within the appropriate guideline standard. Generally a document will begin with a Title style and will have Heading styles to indicate the major headings within the document. Any lists within the document will be styled using the List Bullet or List Number styles and any text that needs to be indicated as important or emphasized will be styled using the Strong or
Emphasis style. Finally, the body text of the document may be styled by using either the Normal or Body Text style.

A. Use Heading Styles to Convey Structure

Explanation

Headings add context and meaning to your text; they provide a method of visual navigation to content as well as an underlying structural navigation. Visually, headings are apparent because they are often a larger and bolder font. However, by using heading styles, structure will be added to the document, and this structure will be detectable by assistive technologies. Screen reading software can detect the headings in the document thereby giving individuals an overall sense of the structure of the document without having to read the entire document. Individuals using screen reading software will be able to navigate the document by heading levels, further increasing the accessibility and navigability of the document. In addition, using headings will facilitate the creation of a table of contents.

Example

When thinking about the application of heading styles to a document, it is helpful to think about the structure of an outline. Following is an example of a short outline. The top-level headings in the document (e.g., main topics) will be styled using the Heading 1 style. Sub-headings to the top-level headings (e.g., sub-topics to the main topics) will be styled using the Heading 2 style. If there are further sub-headings, they will be nested below the higher-level topic to which they relate.

I. Top-Level Heading [Heading 1]
   a. Sub-heading to top-level heading [Heading 2]
   b. Sub-heading to top-level heading [Heading 2]
      i. Sub-heading to sub-heading [Heading 3]

II. Top-Level Heading [Heading 1]

III. Top-Level Heading [Heading 1]
   a. Sub-heading to top-level heading [Heading 2]
      i. Sub-heading to sub-heading [Heading 3]
         1. Sub-heading to sub-sub heading [Heading 4]
         2. Sub-heading to sub-sub heading [Heading 4]

IV. Top-Level Heading [Heading 1]

B. Nest Heading Styles Appropriately

Explanation

It is important that when you use styles, you do so correctly. Use the appropriate style for its intended purpose. Remember, you are using styles to add structure to your document. Styles are not used to merely make various elements of your document look a specific way. For example, only use the “Title” style to format the title of the document.
Word has nine built-in heading styles. They are called Heading 1, Heading, 2, etc. Use the Heading styles to indicate major headings in the document. Use Heading 1 to indicate a top-level heading. If there is a sub-heading for Heading 1, use Heading 2; a sub-heading for Heading 2 would be Heading 3, and so on. Again, you are adding structure to your document, and structurally, the headings should be used in order. For example, do not use Heading 1, then Heading 3 because you like the look of the Heading 3 default formatting. Instead, modify the Heading 2 style to your liking and use Heading 2 before using Heading 3.

In addition to the heading styles, Word provides a Title style. The Title style is used to indicate the title of the document. There should be only one Title style in use in a given document.

New in Microsoft Word 2010 is the Navigation pane. The Navigation pane is a visual tool that enables the document author to view all of the document’s headings and pages in a clear, top-to-bottom format. This functionality is similar to the Document Map tool that was present in previous versions of Microsoft Word. The Navigation pane may also be used to locate and restructure chunks of content by dragging headings. In the Navigation pane, the headings are indented according to their heading levels making it easy to scan both the top-level headings and sub-headings. In addition, selecting a heading in the Navigation pane will jump directly to the corresponding section in the document.

**Steps to use the Navigation Pane to View Nesting of Headings:**

**See Figure 4**

1) Select the View tab  
2) Select the check box “Navigation Pane” in the Show group (the Navigation pane opens on the left side of the screen)  
3) Visually inspect the placement of the headings within the document  
   • Heading level 1’s should be flush against the left edge of the Navigation pane  
   • Heading level 2’s should be slightly indented to the right from Heading level 1’s  
   • Heading level 3’s should be slightly indented to the right from Heading level 2’s  
4) If desired, close the Navigation pane by selecting the “x” in the upper right-hand corner of the pane
C. Use Styles to Format Text

Explanation

Similar to Heading styles, text formatting should be done using styles because it adds structure and meaning to the text. Use the Emphasis (italicized) or Strong (bolded) style for text that is special or that needs the reader’s attention.

Emphasis Style

The Emphasis style may be used to indicate that a word(s) are important. The default format for the Emphasis style is italic. Visually, using the Emphasis style on a word or words looks the same as if you simply clicked the italic button on the formatting toolbar. However, for someone who uses a screen reader, it can tell the individual that you think that word (or group of words) is important. A screen reader user will not know if a word is simply italicized, but with the Emphasis style, a screen reader user could learn that you are emphasizing that particular text.
**Strong Style**

The Strong style is similar to the Emphasis style except the default format is bold. Again, it gives structure to your words, rather than simply changing the way a particular word (or group of words) appears.

**Body Text / Normal Style**

The Body Text style may be used to indicate the text in the body of the document. The Normal style is very similar and may be used instead of the Body Text style.

**D. Control White Space in the Document with Styles**

**Explanation**

The spacing before and after paragraphs, lists, headings, etc. should be controlled and adjusted within the styles that are used. The effect of blank lines may be achieved by adjusting the spacing before or after lines within the style element. Adjusting the space in a document by using the Enter key will result in numerous blank lines in the document. When an individual using a screen reader reads the document, he or she will hear “blank” each time a blank line is encountered that was entered by using the Enter key. Not only will hearing “blank” be annoying to the individual, but if “blank” is heard several times, the individual may think they have reached the end of the document and stop reading. Press “Enter” only to indicate the end of a paragraph.

**Steps to Control White Space with Styles:**

*See Figure 5*

1) In the Styles pane, hover over the style you want to modify
2) Select the down arrow to the right of the style name
3) Select Modify…
4) In the lower left corner of the Modify Style dialog box, select the Format button
5) Select Paragraph
6) Adjust the “Before” and “After” numbers in the Spacing section of the Paragraph dialog box
7) Select OK to close the Paragraph dialog box
8) Select OK to close the Modify Style dialog box
E. Use List Formatting

Explanation

List formatting styles should be used to add structure and meaning to lists.

The List Bullet style should be used for unordered lists (i.e., lists in which the order does not matter). Do not use the buttons on the toolbar to indicate a bulleted list. The List Bullet style is more stable and will be easier to maintain. Again, structure is being added to your document, so use this style when you have a list in which the order does not matter.

The List Number style should be used for numbered lists (i.e., lists in which order is important). Again, do not use the buttons on the toolbar to indicate a numbered list. Use this style when you truly have a numbered list.

F. Generate a Linked Table of Contents for Longer Documents

Explanation

For documents that are more than eight pages, a linked table of contents may be provided. Linked Table of Contents improves the navigation of your document by allowing individuals to skip to certain sections of document as desired. It is recognized that a linked table of contents
is not suitable for all document types (e.g., long press releases, short syllabus documents, etc.). However, whenever appropriate, include a linked table of contents for longer documents (more than eight pages).

**Best Practice**

It is a best practice to generate a table of contents when the document is finished. If a table of contents is generated before the document is finished, the document author will need to continually update the table of contents to reflect the changes in the document.

**Steps to Generate a Linked Table of Contents:**

*See Figure 6*

1) Place the cursor in the document where you want the table of contents to begin
2) Select the References tab
3) Select Table of Contents from the Table of Contents group
4) Select Insert Table of Contents…
5) Select your preferences for the table of contents, keeping the following in mind:
   - Tab leader: Set to dots. The dot leaders that appear from the topic title to the page number increase the readability and comprehension for all users. The dots are read as ellipses and are not bothersome for those using screen readers
   - Recommended to check the box “Show page numbers”
   - Recommended to check the box “Use hyperlinks instead of page numbers”
   - Select the number of heading levels desired in “Show levels”
   - Select the format of the Table of Contents in “Formats”
6) Select the Options… button (the Table of Contents Options dialog box opens)
7) Ensure “Styles” is selected
8) Select OK to close the Table of Contents Options dialog box
9) Select OK to close the Table of Contents dialog box
2.0 Columns

A. Use Column Formatting Instead of Tabs and Spaces

Explanation

The use of tabs and spaces to simulate columns does not result in actual columns. It may appear that the text is in columns; however, the text does not have a column structure and will not be recognized as a column by assistive technology. As a result, the assistive technologies will not be able to accurately read the text.

Screen reading software reads the text in a document left-to-right, line-by-line. A screen reader will read text that is set up in columns using spaces and tabs by reading the first line of column one then the first line of column two, the second line of column one then the second line of column two, and so on. Text read in this manner will be incomprehensible to someone who relies on screen reading software.
**Steps to Format Columns:**

*See Figure 7*

1) Select the text (if you already have text in your document that you want formatted into columns)
2) Select the Page Layout tab
3) Select Columns from the Page Setup group
4) Select the number of columns desired

---

**Figure 7: Steps to Format Columns**

---

**3.0 Tables**

**A. Do Not Use Tables for Layout Purposes**

**Explanation**

Tables should be used to present truly tabular data only; they should not be used for layout purposes. Screen reader users interact with the document and their screen reader depending on what type of text they encounter. There are commands for interacting with plain text and different commands for interacting with text in tables. Table commands include commands for
associating table data with specific column headers. The software will alert the individual when entering a table. If a table is used for layout purposes, the command to associate table text to column headers does not make sense because, by definition, a relationship does not exist. This will confuse and disorient the individual who is using a screen reader.

In addition, text that is in tables used for layout purposes may not convert easily to Braille; the text may not make sense when it is converted to Braille which will have accessibility implications (i.e., confuse and disorient the individual reading Braille).

**B. Do Not Draw Tables**

**Explanation**

Screen reading software cannot read complex tables created in Word using the Draw Table tool because these types of tables usually have cells of different heights or a varying number of columns per row. The screen reading software cannot give the individual context for the table data because it is not possible to associate cells with the row and column headers in tables that were created using the Draw Table tool. Instead of drawing tables, insert tables using the Insert Table command.

**Steps to Insert a Table:**

*See Figure 8*

1) Select the Insert tab
2) Select Table from the Tables group
3) Select the number of rows and columns desired by either visually selecting the table dimensions or by selecting “Insert Table...” and selecting the table properties from the Insert Table dialog box
4) If using the Insert Table dialog box, select OK when finished selecting the number of rows and columns

![Figure 8: Steps to Insert a Table](image-url)
C. Do Not use Heading Styles in Tables

Explanation
Tables that are used to present tabular data generally have a header row (i.e., headers). These table headers are not the same as heading styles. Table headers provide context for the table data, while heading styles provide a hierarchy and structure to the document.

Best Practice
This is not to suggest that tables should display the same formatting throughout the table. Headers in tables may be formatted with a larger and bolded font. This is purely decorative; however for individuals with limited vision or for those with sight, the decorative distinctions will be a positive benefit. The header row will stand out more, making the table easier to read and interpret.

D. Split Complex Tables Up Into Simpler Tables Where Appropriate

Explanation
Tables with complex structures (i.e., multiple header rows) should be split into simpler tables when appropriate. Complex tables with multiple header rows are very difficult, if not impossible, to read and navigate using a screen reader. Splitting the tables up into smaller and simpler tables will aid in the comprehension of the data for everyone including individuals who rely on screen reading software.

E. Control White Space in Tables Using Table Properties

Explanation
White space in table cells should be controlled by adjusting the cell margins or cell padding within the table. Adjusting the spaces in a table cell by using the Enter key will result in numerous blank lines in the cell. When an individual using a screen reader reads the cell, he or she will hear “blank” each time a blank line is encountered that was entered by using the Enter key. Not only will hearing “blank” be annoying to the individual, but if “blank” is heard several times, the individual may think they have reached the end of the table and stop reading.

Steps to Create White Space in Table Cells:

See Figure 9
1) Place the cursor in the cell where you want to change the white space
2) Right click for the context menu
3) Select Table Properties…
4) Select the Cell tab
5) Select the Options… button (the Cell Options dialog box appears)
6) Uncheck the box “Same as the whole table” to make changes to the cell margins (you will be able to check this box later if you want the changes applied to the whole table)
7) Adjust the cell margins as desired. It is best to keep the cell margins between .10 and .30. Anything more or less could affect the readability of the table and cell contents.

8) Check the box “Same as the whole table” if you want the changes applied to the whole table; else keep the box unchecked to apply the changes to the current cell only.

9) Select OK to close the Cell Options dialog box.

10) Select OK to close the Table Properties dialog box.

Figure 9: Steps to Create White Space in Table Cells

F. Rows of a Table Breaking Across Pages

Explanation

It may be difficult to follow the contents of a table row when table rows are allowed to break across pages. The meaning of the data in the tables can get lost, and individuals with cognitive disabilities may be disoriented and lose their place within the table.

Best Practice

A best practice when designing tables is to not allow the rows of a table to break across pages. In most cases, this will be achievable with planning and forethought in the design phase of the document.

Exception

The document author should make every attempt to design the table such that rows do not break across pages. However, in situations in which this is unavoidable, it is acceptable to allow the rows of table to break across pages.
Steps to Not Allow Rows to Break across Pages:

*See Figure 10*

1) Select the entire table
2) Right click for the context menu
3) Select Table Properties…
4) Select the Row tab
5) Uncheck the box “Allow row to break across pages”
6) Select OK

![Select the entire table](image)

**Figure 10 : Steps to Not Allow Rows to Break Across Pages**

Steps to Allow Rows to Break across Pages:

*See Figure 11*

1) Select the entire table
2) Right click for the context menu
3) Select Table Properties…
4) Select the Row tab
5) Check the box “Allow row to break across pages”
6) Select OK
G. Set Header Row(s) to Repeat in Tables

Explanation

Creating an accessible table requires that a header row be identified. The header row in a table is assigned by setting the header row to repeat in tables. This setting should be set regardless if the table spans multiple pages or not. At this time, Word is limited to only one type of header in tables (i.e., header cells that are in rows at the tops of columns).

Exception

Standard 4D indicates that complex tables (tables with multiple header rows) should be split up into simpler tables when appropriate. However, there may be instances when splitting up a complex table is not appropriate and, therefore, complex tables must be included in a document. When multiple header rows are necessary in a table, the standard is to ensure that all header rows are identified as such.

Steps to Set a Header Row to Repeat in a Table:

See Figure 12

1) Select the entire table
2) Right click for the context menu
3) Select Table Properties…
4) Select the Row tab
5) Select the button “Next Row” until you see “Row 1:” toward the top of the Row tab
6) Check the box “Repeat as header row at the top of each page”
7) Select OK
Steps to Set Multiple Header Rows to Repeat in a Table:

1) Select only the header rows of the table
2) Right click for the context menu
3) Select Table Properties…
4) Select the Row tab
5) Check the box “Repeat as header row at the top of each page”
6) Select OK

H. Add Text Alternatives for Tables

Explanation

New in Microsoft Word 2010 is the ability to add text alternatives for tables. The alternate text for tables should be a short summary of the purpose of the table.

Exception

Providing both text alternatives and captions may be unnecessary and may provide redundant information to individuals who use screen reading programs. Whether to provide both text alternatives and captions will depend on the amount of information entered into the caption. If the caption provided provides sufficient information about the table, text alternatives are not necessary. If the caption does not sufficiently describe the table, text alternatives should be added to the table.
Steps to Provide Text Alternatives for Tables:

See Figure 13

1) Select the entire table
2) Right click for the context menu
3) Select Table Properties…
4) Select the Alt Text tab
5) Type the alternate text description into the “Description:” field
6) Select OK

Figure 13: Steps to Provide Text Alternatives for Tables

I. Include Captions for Tables When Appropriate

Explanation

When appropriate, captions should be added for the tables in your document. Captions are appropriate in the following situations: when further explanation of complex images or tables is necessary; when operating under a style guide (e.g., MLA or APA); or when a document is optimized for print.

Best Practice

Captions for tables should be placed above the table. By placing the caption above the table, a screen reader user will know that a table follows and will be prepared to interact with that content in a different way.
Steps to Provide Captions for Tables:

See Figure 14

1) Select the entire table
2) Right click for the context menu
3) Select Insert Caption…
4) Ensure “Label:” field indicates “Table”
5) In the “Caption:” field, type a colon after the number, add one or two spaces, then type a short caption for the table
6) Ensure “Above selected item” is selected in the “Position:” field
7) Select OK

4.0 Hyperlinks

A. Use Text for Hyperlinks rather than URL’s

Explanation

Hyperlinks are links to pages on the Web, other documents, or other areas of the same document. The link text chosen should be text, and the target of the link should be clear to the end user. For individuals who use screen reading software, listening to a URL within a sentence can be awkward and disorienting. Instead, use text for hyperlinks – text that describes the target destination of the link.

Example

An example of using text instead of the URL: “There are 23 campuses in the California State University (CSU) system” instead of, “There are 23 campuses in the California State University (CSU) system (http://www.calstate.edu)”. 
**Best Practice**

There may be times when the document will be printed or when the reader may not necessarily be interacting with the document online. In these cases, it is important that the document author also provide the entire URL for readers. An effective way of providing both the complete URL and descriptive link text is to footnote all links. The descriptive link text will be in the text (and will make sense when read out of context), the link will be footnoted, and the complete URL will be in the footnotes. Following is an example of this technique of providing the complete URL of a web address while satisfying the standard of providing descriptive link text that makes sense when read out of context.

*Humboldt State University*⁵ is a residential campus located in Arcata, CA.

In the paragraph above, the link for Humboldt State University is a live link with descriptive link text. The footnote (3) below repeats the descriptive link text and provides the complete URL.

**Steps to Footnote Descriptive Link Text to Provide Complete URL:**

1) Insert or edit the hyperlink as instructed below (see Figures 15, 16, and 17)
2) Place the cursor at the end of the link text
3) Select the References tab
4) Select Insert Footnote from the Footnotes group (the cursor will move to the Footnote section of the document)
5) Enter the descriptive link text then enter the complete URL (web address). See example of Humboldt State University in the paragraph above and in the footnote section at the bottom of this page.

**Exceptions**

There may be cases in which providing descriptive link text instead of a URL is not appropriate. For example, it may not be appropriate to provide text links on fliers or advertisements that are designed to be printed (individuals reading the flier will not have access to the URL when reading the printed page) or in which learning a specific URL (web address) is a pedagogical consideration. In these cases, it is acceptable to provide the URL.

**B. Ensure Link Text is Descriptive and Makes Sense When Read Out of Context**

**Explanation**

The link text that has been provided should be descriptive, and it should make sense when read out of context. Assistive technology has the ability to provide users with a list of links that are in the document. Link text that is as meaningful as possible will aid users who want to choose from this list of links. Text such as “click here” does not provide the reader with useful information regarding the purpose of the link or the result of selecting the link.

---

³ Humboldt State University: [http://www.humboldt.edu](http://www.humboldt.edu)
C. Ensure Link Text is Identical for the Same Destinations and Unique for Different Destinations

Explanation
To minimize reader confusion, links that have the same target destination should have the same descriptive link text. Conversely, links with different purposes and destinations should have different descriptive link text.

Exceptions
There may be cases in which two links serve different purposes but necessarily point to the same destination (e.g., “report an accessibility problem” and “request materials in alternate format”, both may go to mailto:ati@calstate.edu).

Steps to Insert a Hyperlink (at the current cursor location):

See Figure 15
1) Select the Insert tab
2) Select Hyperlink from the Links group (the Insert Hyperlink dialog box appears)
3) Enter the link text (descriptive link text that you want to appear in the document) in the field, “Text to display:"
4) Enter the URL (web address) in the field, “Address:"
5) Select OK

Figure 15: Steps to Insert a Hyperlink (at the current cursor location)
Steps to Convert Text to a Hyperlink:

See Figure 16

1) Select the text (phrase, words, etc.) in your document that you want to turn into an active link
2) Right click the selected text for the context menu
3) Select “Hyperlink…” (the Insert Hyperlink dialog box appears)
4) Enter the link text (descriptive link text that you want to appear in the document) in the field, “Text to display:”
5) Enter the URL (web address) in the field, “Address:"
6) Select OK

Figure 16 : Steps to Convert Text to a Hyperlink

Steps to Edit a Hyperlink:

See Figure 17

1) Type the URL (web address) in the document. Pressing Enter or the Space Bar after the last character of the URL will turn the link into an active hyperlink
2) Right click the URL for the context menu
3) Select “Edit Hyperlink…” (the Edit Hyperlink dialog box appears)
4) Insert the link text (descriptive link text that you want to appear in the document) in the field, “Text to display:"
5) Select OK
5.0 Non-Text Elements (Pictures, Images, Charts, etc.)

A. Provide Text Alternatives for all Non-Text Content

Explanation

The purpose of this guideline is to ensure that all non-text content is also available as a text description. “Text” refers to electronic text, not an image of text. Electronic text has the unique advantage of allowing information to be presented in many different formats. That is, it may be rendered visually, auditorily (spoken aloud), tactiley (Braille), easily enlarged, or in any combination. As a result, electronic text can be presented in whatever form best meets the needs of the user.

The text description should convey the same information to the user that the image or picture conveys; it serves as an alternative representation of visual information in text format. The description should be short and to the point, while conveying equivalent information. It is not necessary to include the words, “Image of…” in your text description. The assistive technology software will convey that information to the user, and it would be redundant to have that information in the text description as well.

Rationale

Providing text alternatives allows the information to be rendered in a variety of ways by a variety of user agents. For example, a person who cannot see a picture may have the text alternative read aloud using synthesized speech. A person who cannot hear an audio file may have the text alternative displayed so that he or she can read it.
Example

When non-text content is provided, text alternatives for the non-text content should serve the equivalent purpose. Some text alternatives will describe the non-text content. For example, if an image of a screen shot shows a particular dialog box, an appropriate text alternative would be “screen shot of Add Table dialog box”. Other text alternatives will identify the purpose of the non-text content. For example, if a search button uses an image of a magnifying glass, an appropriate text alternative would be “search” and not “magnifying glass”.

Exceptions

If non-text content is intended to be purely decorative, an alternate text description is not necessary (it may even be distracting if there are a lot of decorative images in a document). In HTML, a document author would enter null alternate text, but this is not possible in Microsoft Word. The alternative is to ensure that the alternate text area is either blank (no description) or contains a filename that is intuitive.

Providing both text alternatives and captions may be unnecessary and may provide redundant information to individuals who use screen reading programs. Whether to provide both text alternatives and captions will depend on the amount of information entered into the caption. If the caption provided provides sufficient information about the image, text alternatives are not necessary. If the caption does not sufficiently describe the image, text alternatives should be added to the image.

If non-text content is a test or exercise that would be invalid if presented in text, then text alternatives should at least provide descriptive identification of the non-text content. An example of a test or exercise that would be invalidated if presented in text is an audio-only spelling quiz. In this example, the text alternative might be, “audio-only spelling quiz”.

If non-text content is primarily intended to create a specific sensory experience, then text alternatives must at least provide descriptive identification of the non-text content. An example of non-text content that is primarily intended to create a specific sensory experience is an audio-only recording of an orchestra. In this example, the text alternative might be “recording of city orchestra.”

Steps to Provide Text Alternatives for Pictures, Images, and Clip Art:

See Figure 18

1) Select the picture, image or clip art
2) Right click for the context menu
3) Select Format Picture…
4) Select “Alt Text” from the selections on the left of the Format Picture dialog box
5) Type the alternate text description into the “Description:” field
6) Select Close
Steps to Provide Text Alternatives for Shapes:

See Figure 19

1) Select the shape
2) Right click for the context menu
3) Select Format Shape…
4) Select “Alt Text” from the selections on the left of the Format Shape dialog box
5) Type the alternate text description into the “Description:” field
6) Select Close
Steps to Provide Text Alternatives for SmartArt:

See Figure 20
1) Select the SmartArt
2) Right click for the context menu
3) Select Format Object…
4) Select “Alt Text” from the selections on the left of the Format Shape dialog box
5) Type the alternate text description into the “Description:” field
6) Select Close

Figure 20: Steps to Provide Text Alternatives for SmartArt

Steps to Provide Text Alternatives for Charts:

See Figure 21
1) Select the chart
2) Right click for the context menu
3) Select Format Chart Area…
4) Select “Alt Text” from the selections on the left of the Format Chart Area dialog box
5) Type the alternate text description into the “Description:” field
6) Select Close
Figure 21: Steps to Provide Text Alternatives for Charts

Steps to Not Provide Text Alternatives for Decorative Images:

See Figure 22

1) Select the decorative image
2) Right click for the context menu
3) Select Format Picture…
4) Select “Alt Text” from the selections on the left of the Format Picture dialog box

- If the information entered in the “Description:” field contains a file name that is intuitive (e.g., cartoon.jpg), leave as is and select Close
- If the information entered in the “Description:” field contains non-intuitive information (e.g., C:\Program Files\Microsoft Office\MEDIA\CAGCAT10\j0149481.wmf), erase the contents of the “Description:” field and select Close
B. Watermarks: Ensure Adequate Contrast and Add Text in the Document

Explanation

Watermarks can make reading the text in front of the watermark difficult and therefore present accessibility issues. Watermarks are a special form of WordArt and are stored as images. Beginning with Microsoft Word 2010, alternative text is automatically generated. However, the watermark is stored in the Header of the document which means that an individual using a screen reader will not have access to the watermark (or the alternative text associated with it) unless he or she knew to access the header of the document.

Best Practice

The use of watermarks should be evaluated. If there is a legitimate business need for a document author to use watermarks, then it is important that the following requirements be satisfied:

- Use a text-based watermark instead of an image-based watermark
- Expose the text of the watermark to the users by doing one of the following:
  - Add the text of the watermark to the beginning of the document. For example, add the text, “Document Status: Draft” to the beginning of the document (or as close to the beginning of the document as is feasible)
  - Include the text in the filename (e.g., Standards Document – Draft)
- For all watermarks, regardless of whether they are text-based or image-based, ensure that there is adequate contrast between the text color and the color of the watermark
C. Provide Additional Descriptions for Complex Images/Charts

Explanation

If charts and graphs are complex and require additional explanation beyond what can be provided in the alternate text, provide this additional explanation in the surrounding text. Alternate text descriptions should be short and concise while conveying equivalent information. Some images and/or charts will require descriptions longer than should be entered into the alternate text description area. In these cases, it is appropriate to further explain the image or graph in the surrounding text.

D. Place Graphics and Images “In Line with Text”

Explanation

Objects not placed in line with text are difficult to navigate to and may be inaccessible to people with vision disabilities. Screen readers can only detect and properly read the alternate text associated with objects when they are placed in line with text because objects that are not in line with text are not part of the text layer of the document (similar to text boxes). In addition, in line objects keep their position on the page relative to a portion of the text. Comprehension will be easier when the objects are located near (and are associated with) the surrounding text in which additional explanations may be contained.

Steps to Place Graphics and Images “In Line with Text”:

See Figure 23

1) Select the graphic or image
2) Right click for the context menu
3) Select Wrap Text
4) Select In Line with Text
E. Avoid the use of Images of Text

**Explanation**

The intent of this standard is to require document authors to present information as text rather than using an image of text when they can achieve the same visual effect. This will enable people who require a particular visual presentation of text (e.g. a particular font size, foreground and background color, font family, line spacing or alignment) to be able to adjust the text presentation as required. If for any reason, the document author cannot format the text to get the same effect, then an image of text may be used.

**Exception**

If a particular presentation of text is essential to the information being conveyed, then it is acceptable to use images of text. Note: Logotypes (text that is part of a logo or brand name) are considered essential. When non-text content is presented as images of text, the text alternative shall be the text in the image.

F. Do Not Use Text Boxes

**Explanation**

Text boxes are more like images than text and present accessibility issues. Text boxes are not part of the text layer of the document. Consequently, they are difficult to navigate to, and because they are not part of the text layer of the document, individuals using screen reading software will not know that the text box is in the document. Screen reading software is not able
to access information contained in a text box and it is very difficult, if not impossible, to access
the object without a mouse.

Best Practice
Instead of using text boxes, convert the content of the text boxes to regular text. The visual
effects of a text box can be achieved by using a bordered paragraph.

Steps to Create a Bordered Paragraph:

See Figure 24
1) Place the cursor anywhere within the paragraph to which you would like to add a border
2) Select the Home tab
3) Select the Borders and Shading expansion arrow in the Paragraph group
4) Select Borders and Shading…
5) Select the Borders tab
6) Select the type of border, width of border, and color of border
7) Select the Shading tab
8) Select a fill color (if desired), ensuring there is proper contrast and readability between the
text and background colors
9) Ensure that “Paragraph” is selected under “Apply to:”
10) Select OK

Figure 24 : Steps to Create a Bordered Paragraph
G. Provide Captions for Images When Appropriate

Explanation
When appropriate, captions can aid in the comprehension and meaning of images. Captions are appropriate when further explanation of complex images or tables is necessary, when operating under a style guide (e.g., MLA or APA), or when a document is optimized for print. Examples of when it is not appropriate to provide captions include: when the images are used for decoration or in those rare instances in which text is rendered as images.

Best Practice
Captions for images should be placed below the image.

Steps to Provide Captions for Images:

See Figure 25
1) Select the image or chart
2) Right click for the context menu
3) Select Insert Caption…
4) Ensure “Label:” indicates “Figure”
5) In the “Caption:” field, type a colon after the number, add one or two spaces, then type a short caption for the figure
6) Ensure “Below selected item” is selected for the “Position:” field
7) Select OK

Figure 25 : Steps to Provide Captions for Images

H. Do Not Use Drop Caps

Explanation
A drop cap is a formatting technique in which the first letter of a paragraph is a large decorative letter. Microsoft Word 2010 stores this “letter” separately from the rest of the word to which it is
connected. Consequently, screen reading software will not speak the word properly; it will speak the drop cap letter followed by the rest of the word. This may be disorienting and difficult to follow for someone who uses a screen reader.

6.0 Headers and Footers

A. Observe the Following Rule for Header/Footer Content

Explanation

There are three main areas in a Word document: Header, Main Document, and Footer. Normally, screen reading software will read the text that is the main document. Text that is in the header and/or footer is readable by the screen reader, but the individual must know to look for information there because reading in the header/footer is not a normal reading method.

Acceptable Content

- Running headers
- logos
- page numbers
- copyright messages

Unacceptable Content

- document title
- author or contact information
- date of document update or document version number

Steps to Insert Header:

1) Select the Insert tab
2) Select Header from the Header & Footer group
3) Select the type of Header you want to add

Steps to Modify a Header:

See Figure 26

1) Select the Insert tab
2) Select Header from the Header & Footer group
3) Select Edit Header (the cursor is now in the header area of your document)
4) Make any desired changes
5) Select the Header & Footer Tools tab
6) Select Close Header and Footer
Steps to Insert Footer:

1) Select the Insert tab
2) Select Footer from the Header & Footer group
3) Select the type of Footer you want to add

Steps to Modify a Footer:

See Figure 27

1) Select the Insert tab
2) Select Footer from the Header & Footer group
3) Select Edit Footer (the cursor is now in the footer area of your document)
4) Make any desired changes
5) Select the Header & Footer Tools tab
6) Select Close Header and Footer
A. Do Not Use Color Alone to Convey Information

Explanation

Color is an important asset in document design – enhancing a document’s aesthetic appeal, its usability, and its accessibility. However, some users have difficulty perceiving color. People with partial sight often experience limited color vision, and many older users do not see color well. In addition, people using text-only browsers or monochrome displays will be unable to access information that is presented only in color. Therefore, it is important to ensure that all information conveyed with color is also available without color; do not rely on an individual’s perception of color to differentiate items on a page.

Note: This should not in any way discourage the use of color on a page, or even color coding if it is accompanied by other visual indications.
An example of information conveyed by color differences along would be, “Mary’s sales are in red, and Tom’s sales are in blue.”

Tables 1 and 2 below demonstrate both the incorrect and correct use of color to convey information. In both tables, color is used to code group assignments. Group One assignments are in red, Group Two assignments are in green, and Group Three assignments are in blue. Table 1 incorrectly uses color as the sole means of conveying information. Table 2 correctly supplements the use of color by also identifying the corresponding group using text. The key is to ensure that the information regarding the group assignments are clear and understandable regardless of the color scheme used or one’s ability to perceive color.

Table 1: Poor Example of Color Use

<table>
<thead>
<tr>
<th>Week/Date</th>
<th>Group Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monday, 8/20</td>
<td>Case 1</td>
</tr>
<tr>
<td></td>
<td>Case 22</td>
</tr>
<tr>
<td></td>
<td>Case 5</td>
</tr>
<tr>
<td>Wednesday, 8/22</td>
<td>Case 14</td>
</tr>
<tr>
<td></td>
<td>Case 10</td>
</tr>
</tbody>
</table>

Table 2: Good Example of Color Use

<table>
<thead>
<tr>
<th>Week/Date</th>
<th>Group Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monday, 8/20</td>
<td>Group One: Case 1</td>
</tr>
<tr>
<td></td>
<td>Group Two: Case 22</td>
</tr>
<tr>
<td></td>
<td>Group Three: Case 5</td>
</tr>
<tr>
<td>Wednesday, 8/22</td>
<td>Group One: Case 14</td>
</tr>
<tr>
<td></td>
<td>Group Three: Case 10</td>
</tr>
</tbody>
</table>

To test whether color has been used as a means of conveying information, print the document in black-and-white and evaluate whether any meaning is lost when viewed in this manner.

8.0 Document Metadata

Metadata is essentially a description of the contents of a file. Search engines look for available metadata and report matching results with given search criteria. Providing as much metadata for a file will enhance the effectiveness of search engines and provide your readers with important information regarding the document.

A. Insert the Document Title in the Document Properties

Explanation

When a Word document is opened, screen reading software will first attempt to read the title assigned in the Document Properties dialog box. If the title has not been entered in this area, the screen reading software will then read the file name. File names, much like website URL’s, will often not make sense when read out of context. It is therefore preferable for the title to be read which requires the title be entered into the Document Properties dialog box.
Best Practice: Insert Other Document Metadata As Deemed Appropriate

Information such as Author, Subject, Keywords, Category, Status, and Comments should also be entered. The Author field may be particularly useful if the need arises to contact the author of a document regarding content, revisions, or accessibility concerns.

Steps for inserting document metadata, including document title:

*See Figure 28*

1) Select the File tab
2) Select “Info” from the selections on the left
3) Select Properties
4) Select Advanced Properties (a dialog box opens)
5) Select the Summary tab
6) Fill in the following fields:
   - Title (required): enter a descriptive title of the document
   - Author (highly recommended)
   - Subject, Keywords, and Comments fields recommended if author deems appropriate

7) Select OK

![Figure 28: Document Metadata Dialog Box](image)

**B. Set the Language Properties for the Document**

**Explanation**

It is important to ensure that the language properties for the document have been set because both assistive technologies and conventional user agents (i.e., software that retrieves and
presents Web content for users) need to present text and other linguistic content correctly. Speech synthesizers that support multiple languages will be able to speak the text in the appropriate accent with proper pronunciation. In addition, it allows Braille translation software to correctly format text.

If the language of the document is different than the default language for the template being used, you will need to set the language properties.

**Steps to Set the Language Properties for the Document:**

1) Select the Review tab
2) Select Language from the Language group
3) Select Set Proofing Language…
4) Select the desired language from the list
5) Select OK

**C. Identify Changes in Language for Text (Phrases, Sentences, etc.)**

**Explanation**

For the reasons described in Section 8B above, it is important to identify when the language of the text in a document changes from the main language of the document. If changes are not marked, the synthesizer will speak the words using the default language which will cause pronunciation errors. If you are uncertain whether a change in language is needed, consider whether the word would be pronounced the same (except for accent or intonation) in the language of the immediately surrounding text. For example, the French word for car, “voiture” would be pronounced "voyture" by a speech synthesizer that uses English as its default language.

**Exceptions**

It is not necessary to change the language setting for single words if that word has become an accepted part of the language of the surrounding text. For example, "rendezvous" is a French word that has been adopted in English, appears in English dictionaries, and is properly pronounced by English screen readers. Because this is so common in some languages, single words should be considered part of the language of the surrounding text unless it is clear that a change in language was intended.

**Steps for Identifying Changes in Language for Text (Words, Phrases, etc.):**

1) Select the text for which you want to change the language
2) Select the Review tab
3) Select Language from the Language group
4) Select Set Proofing Language…
5) Select the desired language from the list
6) Select OK
Document Readability

The standards set forth in this document should result in a Microsoft Word document that is accessible to all individuals regardless of disability or assistive technology needs. In addition to the standards outlined above, there are other aspects of document design that authors may implement to increase the readability of their documents.

Items related to document readability are out of the scope of this document. However, the Accessible Technology Initiative anticipates creating a document about document readability. This forthcoming document will be posted to the Professional Development for Accessible Technology in the CSU site. Topics to be covered in this document include, (but are not limited to): font style, font color, background color, and the use of patterned backgrounds.

Accessibility Checker

Introduction

Word 2010 introduces a new tool, the Accessibility Checker, which can assist authors in ensuring that their documents are accessible to individuals with disabilities. The Accessibility Checker is an automated tool that can help to identify and resolve accessibility issues in your documents.

Scope

The Accessibility Checker checks your document against a set of possible issues that users with disabilities might experience when reading a document. Each issue is classified as an Error, Warning, or Tip. Below is an explanation of the elements that the Accessibility Checker identifies for each possible issue. Next to each element is a reference to the CSU Standard within this document.

Error

An accessibility error is given for content that makes a file very difficult or impossible for people with disabilities to understand.

The Accessibility Checker checks for the following errors in a document:

- All objects have alternate text (see Standard 5.0, multiple sections)
- Tables specify column header information (see Standard 3G)
- Long documents use styles to provide structure (see Standard 1.0, multiple sections)

Warning

An accessibility warning is given for content that in most, but not all, cases makes a file difficult for people with disabilities to understand.

4 Professional Development for Accessible Technology in the CSU: http://teachingcommons.cdl.edu/access/index.html
The Accessibility Checker checks for the following warnings in a document:

- Hyperlink text is meaningful (see Standard 4.0, multiple sections)
- Table has simple structure (see Standard 3D)
- Tables don’t use blank cells for formatting (see Standard 3E)
- Avoid the use of repeated “blank” characters (see Standard 1D)
- Headings don’t contain too much information (not a CSU Standard)
- The use of floating objects is avoided (see Standard 5D and Standard 5F)

Tip

An accessibility tip is given for content that people with disabilities can understand, but that might be better organized or presented in a way that would maximize their experience.

The Accessibility Checker checks for the following tips in a document:

- Layout tables are structured for easy navigation (CSU Standard: Do not use tables for layout purposes – see Standard 3A)
- No image watermarks are used (see Standard 5B)
- All headings are in the correct order (see Standard 1B)

Limitations

Document authors must understand that this is an automated tool and should not be considered a substitute for a thorough review of the document or for learning the techniques and steps in creating accessible documents. Automated tools are not a replacement for human judgment and cannot check for all potential problems.

The Accessibility Checker is an excellent tool to check to ensure that you have provided alternate text for all non-text elements and to ensure that you have not skipped any heading levels inadvertently in your document. However, when reviewing the list of issues the Accessibility Checker identifies and the corresponding references and links to the CSU Standards within this document, you will notice that there are many CSU Standards that this automated tool does not identify. Simply put, the Accessibility Checker is an effective tool but should not be used as a substitute for knowing why or how an authoring technique is used in an accessible document.

There may be instances in which issues have been identified by the Accessibility Checker that you deem unnecessary and inappropriate to fix. In these situations, you may save and distribute the file without addressing these issues. When an author understands the underlying concepts, standards, rationale, and techniques, he or she may make an informed decision about the corrections that must be made to a document.

How to Use Effectively

Whenever the Accessibility Checker finds an issue, the Accessibility Checker task pane shows information about why the content might be inaccessible. Selecting the issue from the list then displays instructions on how to repair or revise it.
While it is up to the document author and his or her workflow process to determine when the Accessibility Checker is used, a best practice is to run the Accessibility Checker when you are finished with the document. If the Accessibility Checker is used throughout the document design process, the author will need to check the task pane when the document is complete to ensure that no identified accessibility issues are outstanding in the Accessibility Checker task pane.

**Steps to Use Accessibility Checker:**

See *Figure 29*

1) Select the File tab
2) Select “Info” from the selections on the left
3) In the “Prepare for Sharing” section, select “Check for Issues”
4) Select Check Accessibility (the Accessibility Checker task pane opens and displays any Errors, Warnings, or Tips found in the document)
5) Selecting an identified issue (selecting and activating the item in the Accessibility Checker pane) will take you to the issue in the document. Additional information on the issue (i.e., why a fix is recommended and how to fix the issue) is displayed at the bottom of the Accessibility Checker task pane. [Note: if the content in the additional information pane at the bottom of the Accessibility Checker is difficult to scroll because of an inability to use a mouse, press F6 to focus on the task pane, tab until the focus is in that area, then scroll with the keyboard arrow keys]
6) Fixing the issue, if deemed appropriate by the document author, will cause the issue to no longer appear in the Accessibility Checker task pane
7) You may continue working with the Accessibility Checker task pane open or close the pane by selecting the “x” in the upper right hand corner of the task pane

---

*Figure 29 : Steps to Display Accessibility Checker Pane*
References


Section 508 Refresh Draft (ICT) Standards and Guidelines: Chapter 5, Electronic Documents. Excerpted from ANPRM which was published in the Federal Register on March 22, 2010.


Word 2010 Help Files

Acknowledgments

This tutorial was created at Humboldt State University. Materials were updated from previous versions used at Humboldt as well as adapted from material from the Accessible Technology Initiative (ATI) office at the CSU Office of the Chancellor.

Thank you to Mark Turner from the Accessible Technology Initiative and to the members of the ATI-Instructional Materials (ATI-IM) Community of Practice (CoP) for their input, recommendations, proofreading and suggestions for improvement.